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What is PACS??What is PACS??
The Centricity Picture Archiving and Communications 
System (PACS) provides radiology departments with 
optimal storage of patient data and radiographic 
images. In its most basic form, the PACS system is 
analogous to an electronic file room. Its digital, 
centralized storage system enables you to access and 
transmit images from any workstation on the PACS 
network. 

In a conventional system, film images and reports are stored 
in folders that are filed and retrieved manually. Instead of 
staff members manually carrying films and written reports to 
a file room, PACS transmits digital electronic images and 
reports over a high-speed network to centralized storage. 
After transmission, patient information and images are 
available simultaneously to many users throughout the 
facility. 



Logging InLogging In

Powering Up the Workstation
With the Centricity Workstation powered up, the main Windows 
desktop will contain several icons. You will need to double left
click the Centricity desktop icon in order to run the Centricity
application. 
Logging In
All personal preferences are tied to the user log-in. With cursor 
flashing in the User Name box, type in your user name (Your 7 
character Mysis log on that begins with an “A”). Tab to the next 
Password box and type in your password. Press the Enter Key 
or click Login. Remember that your Password has to be six 
characters or more, contain a Capitol and lower case letter and 
a number.



Changing your passwordChanging your password

Your password is good for 90 daysYour password is good for 90 days
You will be prompted to change it at that You will be prompted to change it at that 
timetime
To change your password, click the To change your password, click the 
change password icon and type in a new change password icon and type in a new 
password following the convention needed password following the convention needed 
for Centricity.for Centricity.



Desktop Appearance 
Once a user logs onto the workstation, the GE selected 
palettes (Work Modes, Patient Jacket and Report) are 
displayed on the desktop. The major functions for 
searching and displaying patient exams and reports, as well 
as setting up user preferences can be accessed through 
these palettes. 



1. Work Modes Palette Title Bar. 
2. Modes of operation. Browse Mode is used to find and open any 

patient in any exam status for review. Verify mode is a technologist 
function and will only allow exams in an arrived status to be 
populated. Dictate Mode is for radiologists. Only exams in a verified 
status will appear in worklists in the Dictate mode. 



3. Worklist Selector. Allows the user to find and select the various worklists for 
their facility. 

4. Quick Access Tabs. Used to quickly locate the most frequently used 
worklists, by user and by mode of operation. Five worklists can be defined 
in each mode. 

5. Column headings. Columns can be sorted and filtered to help find patients 
quickly and easily, except for large worklists such as All Exams and All 
Recent Exams. The status column lets you check to see to what step in 
the workflow process a patient has progressed. 



6.      Work Modes Palette Icons. Quick buttons you can use to perform 
various workstation functions such as marking a study verified or 
dictated, querying an exam or sending an exam to another location. 
Function is performed for the exam highlighted (selected) in the Work 
Modes Palette. 

7.     Worklist. Lists of patients that are grouped together by a common 
quality, All Unread patients, Unread CT patients, etc. The worklist entry 
provides valuable patient and exam information. 



9.     Include comparisons checkbox. Indicates if the user would
like the system to automatically display a historical exam 
that is relevant to the current study.

10.   Display Exam Icon. Allows the user to open the highlighted
exam in the worklist by single-clicking the icon. 



11.   Patient Jacket Title Bar. 
12.   Patient Jacket Palette Icons. Quick buttons you can click on to perform 

various workstation functions such as marking a study verified or 
dictated, querying an exam or sending an exam to another location. 
Function is performed for the exam highlighted (selected) in the Patient 
Jacket Palette. 



13. Report Palette Title Bar. 
14. Report Header Information 
19. Print report Icon. Prints to local printer. 
20. Hide all Palettes. 
21. Display the three GE default palettes configuration. 
22. Display “My Desktop.” User defined palette orientation. 
23. Work Modes Palette Icon in Workstation Task Bar.



24. Open or hide the Utilities palette. 
25. Launch third party applications such as Exam Manager or Internet 

Explorer. 
26. Help Icon. Clicking this icon launches the online operators manual. 
27. Quit Icon. Closes the application and returns the user to the 

Windows Desktop.
28. Log-out Icon. Logs user out of the system, closes the software 

application and restarts the program, returning user to the login 
screen.



Resizing or Moving a Palette
To resize a palette (vertically), move the cursor to either the top or 
the bottom border of the palette. When the cursor becomes a 
double arrow, click and drag the border to make the palette larger 
or smaller.
To move a palette, click in the title bar area of the window and drag 
it to its new location. 



The Workstation Task BarThe Workstation Task Bar

The Workstation Task Bar contains options to Hide all palettes, 
display GE Selected Palettes, display My Desktop, open and close
Work Modes palette, open and close Utilities palette, launch Third 
Party Applications, display the Help Menu, Quit Application and Log 
off User in that order. 



Default PalettesDefault Palettes
To display GE Selected Palettes, press the F7 key on the 
keyboard or click on the      icon in the lower left corner 
of the monitor. To Hide Selected Palettes press the F9 
key on the keyboard or click on the      icon in the lower 
left corner of the monitor. 





Scroll BarsScroll Bars
Scroll bars are available on many of the palettes Scroll bars are available on many of the palettes 
when more information is available. Clicking on the when more information is available. Clicking on the 
arrow or left clicking while dragging the mouse arrow or left clicking while dragging the mouse 
over the bar moves the information into view. over the bar moves the information into view. 
Different types of scroll bars are shown belowDifferent types of scroll bars are shown below



Help Menu 
A Help Menu is available by pressing the F1 key on the keyboard or by 
clicking the       Help icon. The Help Menu is also available on the Work 
Modes palette and the Patient Jacket palette. To close the Help Menu, 
click the in the upper right corner or click the File menu and select Exit. 

Quit the Workstation Application 
Click the       Quit icon on the Workstation Task Bar in the lower right 
corner of any monitor to log-off and close the workstation application 
and return to the Windows Desktop. 

Logging Off 
Logout       performs a Quit and Restart, which closes the application 
and then restarts it. The user is returned to the Log In screen. The 
purpose of this is to reset the application, if needed. 



Quick Access Buttons 
Users may select five worklists they want to access frequently and place 
them on their Quick Access Buttons. These buttons will then act as user 
shortcuts to those worklists. The user can find these five buttons in the 
upper right half of the Work Modes Palette, adjacent to the Worklist 
Selector drop-down menu. 
To assign a worklist to one of the Quick Access Buttons: 

1. Single-click on the Worklist Selector drop-down menu. 
2. Left click and hold the worklist. 
3. Drag and drop it onto the middle of one of the five Quick Access 

Buttons. 
4. When the user releases the mouse, the name of the worklist will appear 

on the button. 
Note: The cursor will have a small rectangle attached to it. 



Column Headings 
The first column to the left of the patient name is an icon that

indicates an exam note is attached to this study. The other 
columns designate the specific type of information displayed in 
the worklist. 

• Patient Name column displays the patient name; last name 
comma, then first name. 

• Patient ID displays the patient medical record number. 
• Accession Number is the unique exam identifier used by PACS to 

identify the separate exams. 
• Procedure is the name of the exam (eg., AMH – CT Head w-o).



Column Headings, cont..Column Headings, cont..
• Mdl refers to the modality (e.g. CT, MR, CR, US, NM). 
• Img refers to the number of images in the file for the procedure. 
• Study Time begins with the time the exam is ordered. This time will 

update when the images arrived in PACS. The time appears in the title 
bar of the exam when it is displayed. 

• On Line indicates the archive status of the images: 
o “Y” means that the images are in the short-term storage. 
o “N” means the exam is off-line and needs to be fetched (retrieved) 

from the permanent storage system. "N" also means NO images. All
dictated reports will be available if exam is completed. 

o “I” means the exam is in the process of being fetched. 
• Status indicates the stage of completion for the exam (Ordered, Arrived, 

Verified, Dictated, Transcribed, Completed, Reference only, Read off-
line, or Cancelled). 



Filtering a Column 

Under the name of each column heading is a white 
rectangle text box called the Query Search area. Click in 
the box for the column you wish to filter. The cursor will 
start flashing in the box. Type in the appropriate patient 
information and press Enter. The worklist will update to 
reflect the filter information. 
The user can apply multiple filters at one time. Used 
filters remain in a drop down menu listed in alphabetical 
order under each column once selected. Double click on 
the column box and a drop down of the past 10 filters 
display. The number of past filters is configurable. To 
delete a filter, highlight the information and press Delete 
on the keyboard. 



Sorting a Column 

A user can sort columns to put that column in a 
particular order. The user can single-click on the 
column name, and the column will automatically 
sort. Patient Name column will sort names 
alphabetically; Study Time column will reverse 
the received order of the exams. 



Function Buttons 

The Centricity Function buttons 
are located on the left side of the 
Work Mode and Patient Jacket 
palettes. 
Create/View Exam       Notes 
function button opens the exam 
note dialog box attached to an 
active exam in the worklist. 
Report Synch       function button 
opens the report palette and 
synchronizes the report to the 
active exam in the worklist. 



This icon allows the user to Send a 
study to a Remote Workstation (Vitrea). 
Highlight an exam from either the Work 
Modes or Patient Jacket palette, and 
click this icon. 

If the user is waiting for an order or 
images to appear on a worklist, they can 
quickly update the worklist by clicking on 
the Refresh button. Refresh if an off-line 
exam has been manually fetched and 
the user is waiting for the images to 
appear. Even if the user has filtered the 
worklist with information, such as patient 
name, modality, date, etc., the filters will 
remain in place while the worklist 
refreshes. 



Use this icon to change a selected 
unverified study to the Verified status. This 
moves your study to the Radiologist’s worklist. 
This tool is available on the Work Modes and 
Patient Jacket palettes. 

If a study is already in a verified, dictated, 
transcribed or completed status, the study can 
be Unverified. This can be done: (a) if two 
exams need to be merged via Centricity Exam 
Manager, or (b) additional images need to be 
added to a study that has already been 
verified. This tool is privilege based.

1. Select the study from the Work Modes or Patient 
Jacket palette. 
2. Click the Unverify icon. The status will update to 
arrived. 



The Get Patient functionality allows the user to 
manually fetch exams from a remote archive to the local 
short-term storage server. 
1. From the Work Modes or Patient Jacket palette, select 

the patient. 
2. Click the Get Patient icon. A warning box will appear 

stating you are about to fetch all historical exams for 
this patient. 

3. Click OK if you wish to fetch all historical exams. 
The Send Exam functionality allows users to send an 

exam to another DICOM receiver. A DICOM receiver 
could be an Advanced Post Image Processing workstation 
or another short-term storage device. This can also be 
used to save an exam in jpeg or tiff format. 
1. Select an exam from the worklist in either the Work 

Modes or Patient Jacket palette. 
2. Click the Send Exam icon. A dialogue box will open 

allowing the user to select the DICOM specific 
receiver needed. 

3. Select the destination from the destination drop-down 
menu. 

4. Click the OK button to complete the task. 



The Print icon allows privileged users to 
print an exam or a worklist from the Work 
Modes palette. When printing exam images 
from the Work Modes palette, the only 
options will be to print all images or 
significant images. The user will need to open 
an exam in order to print selected images 
from that study. To print images: 
1. Select the exam. 
2. Click the Print icon. 
3. Select the Print Film from selected exam checkbox. 
4. Click Print. 
5. Select either All Images or Significant Images. 
6. Select the printer from the drop-down menu. 
7. Choose the format options and then click the print 

button.



Patient Jacket Palette 

When users select an exam in the worklist of 
the Work Modes palette, the Patient Jacket 
palette will update to the name of that 
patient and list all the exams that are 
available on PACS for that particular patient. 



Report Palette 
When a user selects an exam from a worklist, the 
corresponding report will appear in the Report Palette. 
There is a show/hide all fields arrow in the upper left corner 
of the palette allowing the user to display Essential or Full 
Information in the header of the Report Palette. The report 
tab may need to be moved in order to see the typed report.



Exam notes are to be created for Exam notes are to be created for EVERY EVERY exam. History exam. History 
should be obtained and included in the exam note. should be obtained and included in the exam note. 
Exams using contrast need to have the type of contrast Exams using contrast need to have the type of contrast 
and amount included. and amount included. 
If prior studies have been done on the same body part, If prior studies have been done on the same body part, 
this information should also be included in the exam this information should also be included in the exam 
note. note. 
If the Technologist is not logged in, select Create As in If the Technologist is not logged in, select Create As in 
the upper right hand corner of the exam note and enter the upper right hand corner of the exam note and enter 
your User Name and Password. This is how the your User Name and Password. This is how the 
Radiologist will identify who did the examination if any Radiologist will identify who did the examination if any 
questions arise at a later time.questions arise at a later time.

Exam Notes



The exam note will appear on the screen The exam note will appear on the screen 
every time the exam is opened. Be sure to every time the exam is opened. Be sure to 
include only information that is pertinent include only information that is pertinent 
to the exam. These are also viewed by the to the exam. These are also viewed by the 
referring physician via the web. Do not referring physician via the web. Do not 
include information that should not be include information that should not be 
seen by the patient or referring physician.seen by the patient or referring physician.

Exam Notes



Exam Notes

Exam Notes Icon 
The Exam Notes icon next to the Patient Jacket icon allows 
the user to display the Exam Notes box in the selected 
monitor region associated with the active monitor region. 
Each monitor region has its own exam notes icon. If privileges 
are given to a user, selecting this icon will allow the user to 
read, create and hide exam notes for that study. 
Exam Notes provide an enterprise-wide communication 
system that allows supportive information to be permanently 
attached to patient images. The notes carry communication 
between groups such as the Radiologists, Technologists and 
Emergency Department. Users must be privileged in order to 
create, hide/delete the exam notes. The notes can be canned 
for individual groups or the various groups can free text a 
message to another user. The number of characters in the 
free text is limited to 1024 characters. There is a maximum of 
20 exam notes allowed per exam. 



To create an exam note, click on the icon highlighted To create an exam note, click on the icon highlighted 
below.below.



Exam Notes
Select a canned note or type the neccesary information 

below the subject field and select “Save.”



Opening an ExaminationOpening an Examination
An exam can be opened three ways:An exam can be opened three ways:
1.1. You can You can doubledouble--clickclick on the exam you wish to openon the exam you wish to open
2.2. Click on the exam, right click and select Click on the exam, right click and select ““Display ExamDisplay Exam””
3.3. Click on the exam and select Click on the exam and select ““Display ExamDisplay Exam”” in the right in the right 

corner of the Work Mode Palettecorner of the Work Mode Palette



Function BarFunction Bar
Making an Exam Active

Use the mouse to click anywhere in a monitor region where the 
current or historical exam is displayed to make that exam 
active. The title bar color will change from dark to light (or grey 
to blue) when the exam or series becomes active. 

Right above the image(s), you will see the patient’s name, ID 
number, and the date and time of the exam. This is called the 
Title Bar. The title bar can be made smaller to allow more 
monitor space by double clicking with the left mouse anywhere 
within the title bar. A double left mouse click will also re-instate 
the title bar to its original display. Hovering with the cursor over 
the skinny title bar will reinstate it to original size. This only 
applies for that monitor region. 
The functions from the title bar that hide when minimized can 
be found by completing a right click in the skinny title bar. 



Monitor Region Format 
Monitor region format refers to the number of virtual monitors 
that display within a monitor. The user is able to select from 
pre-designed formats. A drop-down menu on the task bar next 
to the Function Keys allows users to change the number of 
monitor regions displayed on that monitor. 
Click the arrow to open the drop-down menu. You will see a 
list of monitor region choices. Click on any one of the choices.
Only the format for the active monitor will change to the 
selected format. 



Image Format 
• Once the monitor regions have been set, the 
user can select the image format. Image 
format is the number of images that will 
display in a selected monitor region. Each 
monitor region has an Image Format selector. 
• Click in the monitor region to be adjusted. 
Place the mouse pointer over the Images 
format Hot Zone button        . A drop-down 
menu will display various Image Format 
options. Move the mouse to highlight how 
many images will display in this virtual 
monitor and then click that choice. 
• The custom selection will allow the user to 
customize the number of images to display in 
the monitor region. 



Selecting/Deselecting Images in Sheet Mode

SELECT/DESELECT icon is found to the right of the Connect 
Button. 
To Select All Images, click the Select icon 
Notice that a grey frame surrounds each image indicating 
the selected image.
To Deselect All Images, 
click the Deselect All 
Images icon. Notice that 
the grey frame no longer 
displays around the images. 



Selecting Multiple Images 

To select multiple images, click on one image, and while 
holding down the CTRL key, click on any other image or 
images. 
To select a range of images, click on the first image the 
user wants to select, hold down the SHIFT key and then 
click on the last image to include. This will select all the 
images between the first image and that last image 
selected. 
A tool applied to one image will apply to all of the images 
selected.



Image Navigation in Stack Display
1. Change the image format to Stack by using the Image Format button in 

the title bar as explained earlier. 
2. Single-click on the manual cine tool and move the cursor to any image. 
3. Press and hold the mouse button down and move the mouse up and 

down to cine through the stack of images. 
Image Navigation in Auto-Cine 
1. Place the images in stack mode. 
2. Click the Hide/Show Cine Controls button located right of the Conn

button in the Title Bar. The auto-cine controls display at the top of the 
image. 

3. Single-click on the double arrows pointing to the right. This will start 
paging through the images automatically. 

4. Single-click on the box in the middle of the arrow keys to stop the auto 
cine. 

5. Use the slide bar to control the speed of frames per second. 
6. Single-click on the HIDE button to turn off the auto-cine application. 



Toggling Image Size 

Users can double-click on any image to change 
it to a full monitor format. The title bar will 
collapse and the image will focus on the screen. 
The user will not be able to utilize some of the 
tools (such as cine, zoom, etc). 
Double clicking on the image will return it to 
normal size, and the title bar will reappear. 



Report Synchronization 
The software includes a visual indicator to 

differentiate Current from Comparison exams that 
display in the monitor regions. 

A Current exam can be identified by italic font. 
Report text and functions apply to the Current exam 

(italicized font) regardless of how many displayed 
exams are on the monitor(s). 

The Report can be synchronized with the images by 
clicking on the Report Synch Icon.





Patient Jacket Icon 

The Patient Jacket icon next to the Report Synch icon, 
allows the user to display the Patient Jacket Palette in 
the monitor region associated with the active title bar. 
Each monitor region has its own Patient Jacket icon. This 
will allow the user to see the patient’s exam history in 
PACS and display the historical studies not listed under 
the Comp button. 



Image Navigation Buttons 

Single and double arrow Buttons on the right side of the 
Title Bar will allow the user to navigate through the 
images. There is a PREVIOUS and NEXT IMAGE button, 
a PREVIOUS and NEXT PAGE button, a SERIES button, 
and a COMP (for comparison exams) button. 
Previous and Next Page buttons (double arrows) only 
show up in Sheet and not in Stack image format. 
If the IMAGE or PAGE button is light gray, this indicates 
that there are more images to view. 
If the IMAGE or PAGE button is dark gray, this indicates 
that there are no more images to view. Click on the 
IMAGE or PAGE button to display the previous or next 
image or page of images. 
The Right and Left arrows on the keyboard will move 
one image at a time. The Page Up and Page Down keys 
will move one page at a time. 



Series Hot Zone Button

Single-click in any monitor 
region. In the Series List, the 
series that displays in that 
particular monitor region is 
indicated by a dark grey 
checkmark. A light grey 
checkmark indicates the series 
that display in other monitor 
regions. 
Checkmarks are not displayed 
when the thumbnails are 
visible. However, the series in 
that particular monitor region 
is bold and other open series 
are italicized. 



Once monitor regions and the 
image format for each region has 
been set, the user can select which 
series should display in each 
monitor region. Each monitor region 
has a Series button listing all the 
series associated with the displayed 
exam. The user can place the series 
into the monitor region by clicking 
on the desired series. When “Show 
Thumbnails” is selected, a 
representative thumbnail image 
from the middle of that particular 
series will display ahead of the 
series description and number of 
images in the series if the user has 
that option selected.

Series ButtonSeries Button



To replace one series with another series, move the 
mouse over the Series hot zone button located to the 
right of the title bar. 
The list of series for this exam displays. The series 
currently displayed in that region is shown with a bold 
checkmark when thumbnails are not displayed, or with 
bold and italicized font when thumbnails are displayed. 
Other series that display in other areas of the monitor(s) 
are shown with light colored checkmarks when the 
thumbnails are not displayed. Move the cursor over the 
series to be displayed. Click the left mouse. That series 
will display in that image region. 

Series ButtonSeries Button



Comp Button 
To replace an exam with a comparison exam, move the 
mouse over the Comp button. A list of comparison exams 
(by body parts) is displayed as well as the option for the 
patient jacket palette. The exam currently displayed in that 
region is designated with a bold check mark and italic 
print. Comparison exams that display in other areas of the 
monitor(s) are shown with light colored checkmarks. Move 
the cursor over the reference exam to display, then click. 
That exam will display in that specific monitor region. 



When a study has been sent to PACS from the 
modality, the workflow of the technologist is to 
Verify the exam thus assuring that all the images 
are available and ready for the Radiologist to 
interpret. Once the study has been opened and 
all images accounted for, the technologist will 
mark the exam Verified from the Exam Function 
menu. This is also the last opportunity for the 
technologist to make any changes (that were not 
made on the modality) to the images such as 
annotations and window/level values. The exam 
then goes to the Radiologists Unread list. 

Use this icon       to change a selected unverified      
study to the Verified status. This tool is available on 
the Work Modes and Patient Jacket palettes. 



Tool Selection

The user has several options with regard to the tool bar. 
The user may Anchor the tool bar at the bottom of the Function Bar. 
Right click in an image to have palette with icons display. The user can 
also right click on an image to have the verbal representation viewable for 
a left click tool selection (Context Manager). 
Use the “Display tool icons in tool palette” checkbox in Utilities > 
Preferences > Display Preferences menu to toggle between displaying 
icons and text in the Tool Palette.



If the user has not anchored the 
Tool Palette, Right click over an 
image to display the modality 
specific standard tool palette. 
In order to select a tool, the user 
can click on the pictorial 
representation. The engaged tool 
icon will look as if it were a 
depressed button. 
Click on the down arrow button of 
the standard tool palette to display 
the extended tool palette. This will 
give you access to all of the image 
manipulation tools available for your 
use. 
To close the tool bar, Click on the X 
in the top right corner of the Tools 
Window 



Mouse Button Defaults 
To change the middle or left mouse button to a different 
tool, click on the “M” or “L” and drag it over the tool of 
choice. Release the mouse button in the middle of the 
icon and the “M” or “L” will display above your selection. 
The system will only allow “State Tools” to be 
designated as the default tool. State tools, when 
selected; require further user interaction to manipulate 
the selected image such as zoom, measure and 
window/level. The system default is “L” mouse as the 
Selector Tool and “M” mouse as the Cine Tool. 
Action tools will affect all selected images without 
additional user interaction. The Invert Grey Scale is an 
example of an action tool. 



Description and Use of Individual Tools 

Selection tool allows the user to manipulate selected 
images with the other tools. This is the Left Mouse 
default. Click once on the Selection Tool, then once on 
any image. This will put a light grey border around the 
image and allow the user to apply any tool function to 
that image. Some tools need to have an image selected 
before they will work on that image. If you try to use a 
tool not selected on an image, an alert message will 
display prompting you to select an image first. 
To select multiple images, click on one image and then 
while holding down the CTRL key, click on any other 
image or images. 
To select a range of images, click on the first selected 
image, hold down the SHIFT key, and click on the last 
image to select. This will select all the images between 
the first and last selected images. A tool applied to one 
image will be applied to all selected images. 



This tool allows user to adjust the window/level 
values of selected images. To select the tool, single click 
on the icon. Move the cursor over the image. Press and 
hold the mouse button down then move the mouse up 
or down to change the contrast or left to right to change 
the brightness. 

Resets selected images back to last saved 
window/level value. 

Window/Level ROI tool allows the user to draw a 
ROI on an image and the w/l within the ROI changes 
based on the anatomy contained within the window. The 
values are displayed in the lower left corner of the 
monitor region. 

Inverts the Gray Scale on selected image(s). This 
will invert the black and whites on images. Click once on 
this tool to invert the image(s). A second click will return 
the image(s) back the original display. 



Four tools are used to change the orientation of the 
displayed image. Select the image(s) that need to be re-
orientated and then click on the appropriate tool. 

Rotates selected image(s) 90 degrees to the right 
or left. 

Flips selected image(s) 180 degrees top to bottom or      
left to right 180 degrees. 

Resets changes made to images back to the last 
saved value. 

This tool allows the user to cine (scroll) through 
images. This is the Middle Mouse default selection. 

Scroll Lock feature will allow the user to lock the 
scroll function of the mouse. Once the scroll is locked, 
the user no longer has to click and drag for the images 
to move in cine mode. Sliding the mouse in either 
direction will activate cine. 

This tool allows user to move forward or backward 
one image at a time. 

This tool allows user to move forward and 
backward by pages. 



The Pan Tool allows the user to pan the image in the 
monitor region. 

Single click on the tool and move the cursor to the 
image. Press and hold the left mouse button down and 
move the mouse around. 
While holding the left mouse button down and the Pan 
tool selected, press and hold the SHIFT key down. Move 
the mouse and the image will zoom. 
While holding the left mouse button down and the Pan 
tool selected, press and hold the ALT key down. Moving 
the mouse will window/level the image. 

This tool allows the user to Zoom the image. Single 
click on the tool and move the cursor to an image. Press 
and hold the left mouse button down and move the 
mouse up and down to magnify the image. Single click 
on the tool and move the cursor to an image. Press and 
hold the left mouse button down and pull the mouse 
towards the user to make the image smaller. Holding the 
shift key down at the same time will pan the image. 
Holding the Alt key down at the same time will 
window/level the image.



Magic glass is used as a magnifying glass. Single 
click on the icon and move the cursor to an image. Press 
and hold the left mouse button down. A box will appear 
with the area within the box magnified. The 
magnification factor will be displayed in the upper right 
corner of the magic class. With the left mouse button 
depressed, single right-click to magnify the entire image. 
With the magic glass tool selected, holding down the Alt 
key will change the window level. 

Measurement tool allows the user to make distance 
measurements. Single click on the icon and move the 
cursor to an image. Press and hold the left mouse button 
down on the area where the measurement is to start, 
Click and drag the mouse to the end of the 
measurement and release the mouse. A line will appear 
to mark the measurement. 
To resize a measurement, select it with selection tool or 
by holding down the CTRL key and boxes will appear on 
each end of the line. Click and hold the mouse on one of 
the boxes. Drag the mouse to resize the measurement. 
Release the mouse at the end point. 



This tool allows the user to place an arrow on image. 
Select this tool and move the mouse to the area on the 
image you wish to place the arrow. Click and hold the 
left mouse button down to place the arrow. Drag the 
mouse in the direction that the user wishes the tail of 
the arrow to be drawn. Release the mouse. 
Multiple arrows are placed on an image. To delete an 
arrow, click on the Selection tool and then on the arrow. 
Boxes will appear on either ends of the arrow, click on a 
box and hit delete on the keyboard.



This tool allows the user to add Text Annotation to 
an image. Select this tool and move the mouse to the 
area on the image you wish to place the text. Press and 
drag the mouse to draw a box. Type desired text in the 
box.
To change the font size of the text, select the text first 
with the Selection tool. Click on Change Annotation Font 
in the Image Function tab; select the text format/size 
choice, Click OK. The selected text will change. 
To reposition an annotation, select the annotation with 
the Selection tool. Press and hold the mouse on the 
annotation and drag it to the desired area. 
To resize a text annotation, select the text with the 
Selection tool. Boxes will appear at the four corners of 
the text. Click and hold the mouse on a box and drag 
the mouse to create the desired size. 
To delete a text annotation, select the text with the 
Selection tool. Boxes will appear at the four corners of 
the text. Click on the box then press Delete on the 
keyboard. 



Oval, Rectangular or Irregular shaped Regions 
of Interest (ROI) measurement tools. Select the ROI of 
interest and move the mouse to the area to be 
measured. Click and drag the mouse to create the ROI, 
release the mouse. The following are displayed: 
Area – the total area of the Region of Interest displayed 
in either millimeters or pixels Max – The maximum pixel 
density value of all of the pixels included in the ROI 
Min – The minimum pixel density value of all of the 
pixels included in the ROI 
X – The mean or average pixel value for the ROI 
SD - The standard deviation of the pixel values, in other 
words how spread out the values are. 
These measurements display in the lower right hand 
corner of the screen. 

This tool displays pixel lens value of the X and Y-axis 
for the pixel at the point of the cursor. Select the tool 
and as the mouse moves around the image, the 
measurement will display in the upper middle area of the 
image. 



This tool allows the user to define a specific zoom 
factor (ZF). Right click on the icon to enter desired ZF. 
Four Zoom Factors are stored in the icon. Left click on 
the images to apply a Zoom factor. 

Zooms selected image(s) by 2 times the image size 
shown on monitor tool. 

Zooms selected image(s) by 1/2 image size shown 
on monitor tool. 

Spatial Cursor shows a point on cross-referenced 
planes and/or synchronizes navigation and cursor 
locations among stack views of different image series 
with opposing planes (such as CT/PET) when series 
share the same frame of reference. 

Multi-Planar Localizer identifies the same point on 
images in orthogonal views that are cross-referenced to 
each other. Select the tool and move the mouse to the 
area of interest. The tool will take the images to the 
same plane, same point in all cross-referenced series. 



This is the Image Information Tool. This tool shows 
the DICOM Header Information for the selected image. 
Select an image, Click on this tool and the image 
information will display. This information is also printed 
by Clicking on the Print box located at the bottom of the 
page. 

Fit to Display Region Tool will resize the image to fill 
the monitor much like the Reset function. 

Mask or add a shutter to the image. Using one of the 
ROI tools, draw an ROI on the image. Select the mask 
tool and apply it to the image. The area outside of the 
ROI will turn black. 



Logging Out 
Logging out will close the program, restart the 
applications and return to the login screen so the 
workstation is ready for the next user to login. The user 
will single click on the icon. A dialog box will display a 
message asking if the user wants to logout. If so, the 
user should click on “Yes.”
Quitting will log the user out. A dialog box will appear 
asking if the user wishes to quit the program. If so, click 
on Yes and the application will return to the Windows 
Desktop. 


